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cerer1  EMAIL CONCEPTS

i : INFOcus

Email provides a great way of communicating with friends,
colleagues, business associates and the like. But with email comes
certain responsibilities such as knowing how to protect yourself and
others from viruses, understanding etiquette, dealing with spam and
more.

In this session you will:

gain an understanding of how email works

gain an understanding of email addresses

gain an understanding of the benefits of email
gain an understanding of general email etiquette
gain an understanding of emails and viruses.

SN X XX

© Watsonia Publishing Page 1 Chapter 1 - Email Concepts



ICTICT107 - Use Personal Productivity Tools

How EMAIL WORKS

‘Email’ is an abbreviation of electronic mail and or they may be located some distance apart and
refers to a message that is sent from one connected via the internet. Here we’ll look at the
computer to another. The computers may be in main components of an email system that facilitate
the same building and linked via a local network, the sending and receiving of emails.

Email Client

To send email from your computer you will need an email application (which is also known as an email
client). The email client allows you to compose and send emails to other people, and to receive, read
and delete emails.

The email client could be standalone and installed on your computer (like Microsoft Outlook which is
supplied with Microsoft Office) or it could be web-based (such as Gmail, Hotmall etc).

Email Server

While an email client is used for writing and reading emails, it is the role of an email server to ensure
that email is dispatched to the correct location and recipients.

The email server takes the emails that you have created and sends them through the appropriate
electronic pathways to the intended recipients. It also collects email messages that people are sending
to you and delivers these emails to the email client on your computer.

If you send email messages to people in your company, these messages will generally only pass
through one email server — the one that looks after the internal email in your business. This will most
likely be something like Microsoft Exchange Server. When you send an email to a colleague within your
company, that email is sent to the server and the server then passes it to the email client on your
colleague’s computer — this is done in an instant.

When you send email via the internet, however, the business of email servers becomes more
complicated. Generally, it is your Internet Service Provider (ISP) who handles your internet email, and,
given the volume of mail they handle, they will have quite a few computers to do this. With internet email
there are separate servers that handle outgoing email (email that you are sending) and incoming email
(email that someone is sending to you). Outgoing email is handled by an SMTP server (SMTP stands for
Simple Mail Transfer Protocol), while incoming email is handled by a POP server (POP stands for Post
Office Protocol) or IMAP server (IMAP stands for Internet Message Access Protocol).

To be able to send and receive emails via the internet, computers need to be connected to both an
SMTP and POP/IMAP server. Therefore, when you send an email to someone via the internet, it leaves
your email client and goes to your ISP’s SMTP server. From here it is sent to the destination SMTP
server which collects the email and places it in the appropriate location so that it is accessible to the
recipient’s email client through POP or IMAP services. The recipient's POP/IMAP server then passes it
to the recipient’s email client. A summary of this process is shown below.

Sender’s LANor Sender’s - nternet Recipient’s
Email Client internet SMTP Server SMTP Server
. Recipient’s
gﬂez'ipgz;ﬁt POP or IMAP
Server

Email Account

To use an email server you will need to have an email account. An email account is normally made up of
two components: a user name which identifies you to other people and the system, and a password
which ensures that other people can’t access your mail.

With a proper user name (sometimes known as a user ID) and a password, your computer can connect
to an email server.

© Watsonia Publishing Page 2 Chapter 1 - Email Concepts



ICTICT107 - Use Personal Productivity Tools

EMAIL ADDRESSES

Just as your street address identifies where you a single line of characters. Once you understand
live, an email address identifies where other what they mean, the characters can tell you a great
people can send emails to you. However, unlike deal about the owner of the email address.

street addresses, email addresses comprise only

Identifying Email Addresses
An email address is a unique address on the internet that allows people to send email messages to
you.
An email address is written using the following format:
username@domainname.topleveldomain.country
An example of an email address might be:
jane@watsoniapublishing.com.au
The @ symbol in the middle of the address is known as an at symbol. If read aloud, the sample email
address above would be spoken as ‘jane at watsonia publishing dot com dot au’.
Note that email addresses are not case sensitive. But, in most locations the standard convention is to
write email addresses in lowercase.

The User Name
The user name is used to identify the name of the owner of the email address. It is usually descriptive
and pretty close to the actual name of the person. It could be just the first name, just the last name, both
first and last names, first name plus the first letter of the person’s last name, and so on. For example,
Jane Smith may appear as: ‘jane’, ‘smith’, ‘janesmith’, ‘janes’, ‘jsmith’ and so on.
While there are no rules governing how the user name should appear, some workplaces have
established a particular style that they want you to use. Your system administrator at work will probably
set up your email address for you following company practice.

The Domain Name
The domain name helps the internet identify the location of the email server that is hosting the email
account. Sometimes, the domain name reflects the name of the Internet Service Provider (e.g.
janes@bigpond.com) and other times it might be the name of your workplace (e.g.
jane@watsoniapublishing.com).

The Top Level Domain
The top level domain normally consists of three letters and identifies the type of organisation
associated with the host’'s name. Examples of common top level domains include:

.com private or public company

.gov government department or organisation

.edu educational institution

.net networks usually reserved for Internet Service Providers
.org non-commercial organisations

The Country Identifier
Email addresses outside the United States are usually identified with an additional two letters at the end.
Some of the more common ones are au for Australia, uk for United Kingdom, nz for New Zealand, de for

Germany, fr for France, and so on.
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THE BENEFITS OF EMAIL

There is little doubt that email has provided the
greatest communication revolution since the
invention of the printing press. With many people
email has all but replaced the use of regular mail,
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and billions of messages are sent every day. Email
presents enormous benefits and advantages over
traditional mail. Some of these are presented
below.

It’s Fast

Using email, you can send a message to someone on the other side of the world literally within seconds.
It is possible, therefore, to have an email ‘conversation’ where you are sending short messages back
and forth with someone next door, in the next state or territory, or even on another continent.

It’s Cheap

These days many small businesses can use free web email services to send and reply to email which
helps to save money. Email means that businesses no longer have to rely on potentially expensive
phone calls or the cost of mailing documents and information. It also allows you to get things done in a
more efficient time frame which allows you to take on more customers and improves the business’

reputation.

It’s Convenient

Email has become popular largely due to how convenient it is. As opposed to hardcopy files, email can
be accessed anywhere. This allows greater flexibility in the workplace, meaning even if you are out in
the field, at a conference, or on the road you can still access and send information. For example, if you
are travelling you can use your phone or mobile device to send emails as long as you have access to
Wi-Fi or mobile data. If you don’t have access to a mobile device, you could use a computer at an

internet café or hotel.

Most employees now feel more comfortable using email than traditional letters or memos.

As opposed to a phone call, an email allows one to have time to carefully word sensitive subjects and
create a more professional line of communication.

It Provides A Record

Emails that you send to other people are kept in the Sent box, allowing you to keep a record of all of

your email interactions. You can search your emails to find correspondence with specific people or on a
specific subject, enabling you to easily refer back to a conversation without having to bother the people
involved. You can also choose to archive important emails that may be needed in future, such as emails

containing important information or emails you may need to retain for legal reasons.

It Provides Access

Email provides you with a way to communicate with almost anyone in the world. The vast majority of
businesses and even individuals will have an email address. This makes contacting potential clients
much easier and allows you to send marketing materials and such out to both existing and potential

customers.
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EMAIL ETIQUETTE

It is important to remember that unlike a phone habits when writing email messages. Quite a few
conversation, an email conversation is there guidelines have now been developed to help you
forever and can be referred back to at any time. some of these are listed below.

Therefore, you should adopt courteous and polite

The Beginning And The End

Ensure that you begin your emails with a courteous greeting and end them with a courteous closing. It is
usually seen as polite to address the email to the recipient and sign off with your name.

Short Is Sweet
Ensure emails are concise and to the point so that you do not waste the recipient’s time.

Spelling And Grammar

When you have composed your message spend some time using the spell checker to check the
spelling. Then re-read the message and ensure that there are no typos or spelling and grammar
mistakes. Emails that have errors look unprofessional and may not be taken seriously.

Make The Subject Line Meaningful

Always put meaningful text in the subject line of a message, such as ‘Sales Figures for June’, and so on.
This ensures that there is a greater chance that the email will be read in a timely manner as the person
receiving the message will know what the content is about. It also makes it easier for the person to find
the email again.

Watch What You Say

When we talk to someone face to face there are many nonverbal cues that help us to interpret what is
being said, such as body language and tone of voice. In an email you can only read what has been
written, so when composing an email be careful if using sarcasm or humour as it can easily be
misinterpreted.

Avoid Flaming

Flaming is the act of telling somebody off using an email — and it should NEVER be done. If you have an
issue with someone, contact them over the phone or face to face, but never through an email. The big
danger with email is that it can be read over and over again. If you use email to dress down someone
they can read it several times and become angry or upset. They may flame you with an equally or even
more vitriolic email.

Don’t SHOUT

Avoid using capital letters (except in the proper literary way for sentence starts, names, and the like) as
in an email it can come across as shouting.

Check The Attachments You Send For Viruses
Always scan documents for viruses before sending them as attachments.

Protect The Privacy of Others

When you want to send an email to a group of people you enter their email addresses either in the To or
the Cc fields. There can be two problems with this: firstly, all recipients know exactly who else received
the message, and secondly, the email address of each recipient may be visible to all of the other
recipients. If you are sending a message to many people and it is not necessary for the recipients to
know who else received the message, put their addresses in the Bcc field and put your own address in
the To field — Outlook needs to have at least one address in the To field.
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EMAILS AND VIRUSES

A virus is a computer program transmitted on a hard drive, others can tie up traffic on a
(usually) via the internet that infects computers computer network, while others can replicate and
with the intent of causing damage to your files send themselves to other computers using your
and/or software. Some can delete all information contacts.

Types of Viruses

There are many types of viruses, the most common being: boot sector viruses that infect the start-up
program of your computer, program viruses that infect software programs on your computer, and
macro viruses that infect macro programs written in Microsoft Word or Microsoft Excel. Within these
types there are two broad categories: Trojans, which appear hidden and perform their nasty deeds
without you noticing; and Worms which remain invisible, consume the resources on your computer, and
appear only as your computer begins to slow down.

How Do You Get A Virus?
At the present time there are several ways that a virus can get itself onto your computer:

1.

From a software program that you download from a website. The software program (usually from
a dubious source) will contain the virus that will infect your computer when the software is run.

From an email containing an attachment (this may be a program or a document with a macro
virus) which has been designed to automatically start as soon as you double-click on the
attachment to open it.

From an email containing corrupted web links that enable a virus to download onto your
computer when you click on the link.

Note, however, that some email viruses will launch without even being opened — they will launch
when you view the infected message in the preview pane of your email software!

How Do You Prevent Viruses From Infecting Your Computer?

The best way to protect your computer is by not having it connected to the internet or any form of
network. However, this is obviously impractical in this day and age. Instead, you should follow some
basic rules to minimise your risk of being infected.

Install, use and constantly update a good anti-virus software application on your computer, such
as Nortons, Symantec and so on. Set up the anti-virus software so that it runs in memory — this
ensures that it is vigilantly and constantly checking incoming files for possible dangers and
threats.

Install a firewall — this is special software that protects your computer from unwarranted entry
from the internet. Your company may already have a firewall set up.

Never click on links in emails from people you don’t know, just delete these messages
immediately. If you want to check whether the web address in a link is valid, manually type it into
the address bar in a browser.

Because hackers can readily raid email contact lists, carefully read emails from friends. If an
email appears suspicious, don’t click on any links or download any files. Delete it and ring your
friend. If it was valid, they can re-send you the email.

Always use the anti-virus software to scan email attachments and never open an attachment
until it has been scanned and cleared.

Never download software from dubious sources, such as screensavers, icons, freeware and so
on.

Note: With the sophistication of hackers and virus writers increasing daily, ensure that you check all of
your incoming email very carefully!
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cerer2 GETTING STARTED WITH OUTLOOK

( : INFOcus

Microsoft Outlook 2016 is a time and information management
program that helps you to manage your day-to-day tasks and
information quickly and effectively.

This chapter covers some of the basic principles and navigation
methods to help you get up and running with Outlook 2016 as
quickly as possible.

In this session you will:

v/ gain an understanding of what Outlook is used for
learn how to start Outlook from the desktop

gain an understanding of the common Outlook screen
elements

learn how to use the ribbon

gain an understanding of Backstage View in Outlook
gain an understanding of the Quick Access Toolbar
learn how to navigate to specific features of Outlook
learn how to use Peeks

learn how to work with the Folder Pane

learn how to work with the To-Do Bar

gain an understanding of the Mail screen

gain an understanding of the Calendar screen

gain an understanding of the People screen

gain an understanding of the Tasks screen

gain an understanding of the Notes screen

learn how to close Outlook.
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UNDERSTANDING OUTLOOK 2016

Microsoft Outlook is designed to help you users. You can use Outlook to communicate with
manage the way that you organise the day-to-day others, to keep track of your appointments and
aspects of your business and personal life and meetings, and to manage the contact details of
the way that you interact with other computer individuals or businesses.

Key Features of Outlook 2016

Microsoft Outlook is both a personal information manager and electronic messaging system rolled into
one. Outlook can be used to keep track of your diary, hold the contact details of your customers,
suppliers and associates, schedule meetings, send messages, and generally keep track of things you
have to do.

To do this, Outlook provides you with four main tools. These are Mail, Calendar, Contacts and Tasks.
These tools work together, as well as independently, to provide you with a useful package known as
Microsoft Office Outlook 2016.

Mail The Mail feature allows you to manage electronic mail. You use this aspect of Outlook
to send messages and to receive them from others. These messages can either be
ones sent from within your own organisation (internal email) or externally using the
internet.

Calendar The Calendar feature provides you with an electronic diary which can also be used to
schedule and plan meetings with other people connected to your computer system or
over the internet.

Contacts The Contacts feature allows you to manage business and personal contacts by
recording the names, addresses, telephone numbers, and email details of people
such as colleagues, customers, suppliers, friends, relatives, and the like.

Tasks The Tasks feature provides you with a To-Do list. You can also use it to prioritise
tasks and to delegate them to others and track how many of them have been
completed.

How OQutlook Is Used

Outlook can be opened and used as required, or it can be left open and operating behind the scenes
while you are working with other applications. Generally, it is left open so that new mail and invitations
can be received at any time. Outlook can then notify you even if you are working with another
application.

Since it is designed to allow you to communicate with other people, Outlook will operate on both your
network and internet connections.
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STARTING OUTLOOK FROM THE DESKTOP

To send and receive emails, you must first start
Outlook. If your computer uses Windows 10 it wi

need to open Outlook by using either the All apps
I option in the Start menu or the Search the web

open to the desktop. Unless you have previously and windows bar.

created a shortcut icon on the desktop you will

Try This Yourself: c

Before you begin, ensure that
your computer is switched on
and the desktop is displayed...

If there is no Outlook icon in
the taskbar at the bottom of the
desktop, click on the Windows
icon, as shown, to display the
Start screen

Click on All apps to display a
list of all the apps on your
computer

Scroll down to the W section
Outlook 2016 is listed here...

Click on Outlook 2016 to start
Word

Right-click on the Word icon in
the taskbar to display a menu
of options, as shown, then
select Pin this program to
taskbar

You can now click on this icon
to open Word from the
desktop. This icon will remain
in the taskbar unless you
remove it...

Repeat step 5 to select Close
window to close Word

Click on the Outlook icon in the
taskbar to open Outlook again

@ =m Life at a glance

Fritz Winters
New Products Presentation

P3 PowerPoint 2016 >
1Password 4

Bl Windows Media Player

[Ps] Adobe Photoshop cC.. > e

Adobe InDesign CC 20... > Microsoft Edge
Mostly Cloudy

e S

Canberra Phone Compa...  OneNote

Control Panel

Play and explore

et

Films & TV

ELBO

A NIKKEI 225 1
Y
YN
File Explorer > "3 ),
Moper & ‘ ‘

@ Settings

) Power ﬁ u

:E All apps

B New E-mail Message

New Appointment
= New Meeting
New Contact
New Task

Outlook 2016

Pin this program to taskbar

Close all windows

o BCEC

For Your Reference...

To add a Outlook icon to the desktop taskbar:

1. Display the Start menu, then click on All
apps

2. Right-click on Outlook 2016

3. Select Pin to taskbar

Handy to Know...

e You can start Outlook by clicking in the
taskbar Search... bar, typing word, then
clicking on Outlook in the list of search
results.

¢ Pin Outlook to the Start menu by displaying
the All apps list, right-clicking on Outlook
2016 and selecting Pin to Start.
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COMMON OUTLOOK 2016 SCREEN ELEMENTS

Outlook can do so many different things for you Outlook works, what data it receives, and what
and as a consequence its screen is probably the functions a person prefers to use regularly.
most interesting of all. No two Outlook 2016 Nevertheless, your screen will have many of the
screens will ever appear alike because of how key features that are shown below.

Inbox - ivanarobinson@outlook.com - Outlook

Send / Receive Folder Wiew ADOBE ~DF & Tell me what you want to do

Ijl ,-_|'.j 3 Ignore x E_\ﬂ (ﬁ—\ﬂ ﬁ—\'] m ¥ Move ta: 7 & To Manager ¥ Move~ 1 Unread/ Read | Search People D
e N .I\T - Clean Up~ B i [ ‘6 = éd =T Team Email v Done =7 Rules ~ H. Categorize = [E= Address Book o
ew ew elete eply Reply Forward g . | | by
Email ltems~ &oJunk~ Al B - | CReply&Delete ¥ CreateNew 7 BoneNote  [*FollowUp~ Y Filter Email - Account -
| New Delete Respond Quick Steps [Fl Mave Tags Find Adobe Send & Tr.. A
e__ N Search Current Mailbox .. J | Current Mailbox ~ 2 Reply fé':(i Reply All (2} Forward
. . s Cacebook <notification=kidoud1151k @faceboo il.coms - 31/03
b my outlook data file... All  Unread By Date Newest & acebock <notification+kjdpud1151k_@facebookmail.com> 81 Thu 31/03
4 Last Week Ivana, you have 3 new notifications, 1 message and 1 poke
4iyanarcbinson@outl... Facebook o Click here to dnwnl.nad pictures. To help protect your privacy, Qutlock prevented automatic download of
e Ivana, you have 3 new notif... Thu 31/03 some pictures in this message. “
Inbax: 601 Alot has happened on
Drafts (This computer onl
w 5 2 Facebook =
Sent ltems Ivana, you have 3 new noti... Tue 29/03
Alc c
AT — lot has happened on N .
. 4 Two Weeks Ago X You have new notifications.
Junk E-mail Facebook
Cuth Ivana, you have 3 new noti... Sun 27/03
e A lot has happened on . f
S A lot has happened on Facebook since you last logged in. Here are some
earch Folders 5 - . .
Facebook notifications you've missed from your friends.
Ivana, you have 3 new noti...  25/03/2016
A lot has happened on
E= :
Facebaok sh  Ivana Robinson
b
Ivana, you have 3 new nofi..  23/03/2016 :
A lot has happened on
1= = s .. .
I Adobe Systems - .
ltems: 612 Unread: 601 This folder has not yet been updated. £} Disconnected ] & - 1 + 1099}—— e
L8 )

The Outlook screen will have the following key features listed below, regardless of whether you're in
Calendar, Tasks, Mail, and so on.

The File tab is used to access the Backstage view which contains settings that are not directly
related to creating or managing Outlook items such as Print and Save commands, opening
calendars and importing files. Outlook Options are also available so that you can set your
working preferences and options for Outlook 2016.

o The ribbon is the tabbed band that appears across the top of the window. It is the control centre
of Outlook 2016. You use the tabs on the ribbon to access the commands that have been
categorised into groups. The commands include galleries of options that you can select from,
such as the Quick Steps gallery shown here.

e The Folder pane, which is collapsed by default, contains folders for each view, such as Mail or
Calendar. You can expand the Folder pane to see the items in the folder or click on [All
Folders] to temporarily see the items. The Folder pane was previously known as the
Navigation pane.

o The Navigation bar provides a very quick way of switching between the various Outlook
features such as Mail, Calendar and so on.

You can also display peeks (small windows showing key information) by pointing to Calendar,
People or Tasks in the Navigation bar. You don’t need to switch to the feature to see this
information. For example, pointing to Calendar displays today’s events, People shows your
favourite contacts and lets you search for a specific contact, and Tasks includes a list of today’s
tasks. Note: a peek doesn’t appear when you point to Mail in the Navigation bar.

e The status bar indicates what is going on in Outlook at the present moment. It also changes
depending upon the feature you are using and the tool you are working with.
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USING THE RIBBON

The ribbon is the command centre for Outlook
provides a series of commands organised into
groups that are placed on relevant tabs. Tabs

are activated by clicking on their name to display
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Lt the command groups. Commands are activated by
clicking on a button, tool or gallery option.
Everything you could possibly want to do in Outlook

will be found somewhere on this ribbon.

Try This Yourself:

Before starting this exercise
ensure Outlook has
started...

a File

Home Send / Receive Folder Wiew ADOBE PDF Q@ Tell me what you
Ijl |._|": 5 Ignare x E;\q (ﬁ;\q ﬁ;\ﬁ 5] Move to: 7 87
. .l': 7 Clean Up~ . o Ie 5 9d EJ Team Email v'D
ew ew elete eply Reply Forward [ . [
. [y
Email Iltems~ & Junk~ Al B | S RepyaiDelete ¥ C
MNew Delete Respond Quick Steps

Examine the groups on the
Home tab, such as New,

Home Send / Receive Folder ADOBE PDF Q Tell me what you

Delete, Respond etc Q i&# Show as Conwversations F'GQate (r::'- From
Change View Conversation Settings Message |23 nw .
These are the most View~ Settings View Conversafion Settings ™ | e+l 1~ H Cotegories
Commonly used commands Current View Messages Arrangement
relevant to the current
Outlook feature (e.g. Inbox in e File ~ Home  Send/Receive  Folder [V ADOBEPDF  Q Tell mewhatyou,
Mail here)... S
i . (9 ;:? ["] Show as Conversations E‘GQate =3 From
e Clieisem it Yiew Change Vigw P"_EEEt Conversation Settings Mes.sage =3 To ==l Categories
The commands on this tab MiewsScitings View Preview
=l === Arrangement
are used to change how the b= EES| — :
information will dISplay in the Compact Single Preview tailbox .. R | Current Mailbox - £ Reply
WindOW.. . Manage Views... By Date = Newest 4
Clle on Change VleW in the Save Current View As a New View...
e C t Vi t Apply Current View to Other Mail Folders... ﬂ Click h
urren 1ew grOUp 0 wana, you nave 3 new notif... Thu 31,/03 somepg

display the View gallery

A lot has happened on

This includes three viewing
options as well as three
menu options at the bottom
of the gallery...

Click on each of the tabs
and examine the commands

Some of these commands
open dialog boxes...

On the Folder tab, click on
New Search Folder in the
New group to open the New
Search Folder dialog box

Click on [Cancel] then click
on the Home tab

Mew Search Folder

*

Select a Search Folder:
Reading Mail
{ Unread mail
Mail flagged for follow up
Mail either unread or flagged for follow up

Impaortant mail
Mail from People and Lists
Mail from and to specific people
Mail from specific people
Mail sent directly to me
Mail sent to public groups
Organizing Mail

‘Customize Search Folder:

Search mail in: | ivanarobinson@outlook.com

Cancel

For Your Reference...
To use the ribbon:

Handy to Know...

e Additional tabs known as contextual tabs
1. Click on a tab to display the commands appear in specific circumstances. For
2. Click on a tool to activate a command, fg&?geé %ﬁ%‘;:g;k t?\g Ezﬂ)é:)osgr?gltgl:
alippteyy @ gl el eleypley) @ ClRlor e Message tab will appear. This provides quick
access to all of the tools you may need while
composing the reply message.
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UNDERSTANDING THE BACKSTAGE VIEW

The ribbon lets you work directly with an Outlook
item — you can create an email, format it, send it,
and much more. The Backstage view, which is

accessed using the File tab, provides commands
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that are not directly related to creating or managing

an Outlook item. You can access account details,
clean your mailbox, save attachments and

configure other settings in Backstage view.

The Backstage View

The File tab on the ribbon is
not a normal tab — as you can

tell by the fact that it is coloured.

Clicking on the File tab
launches a mini-program within
Microsoft Outlook known as
Backstage view. The
Backstage, as it's known for
short, occupies the entire
screen.

At the left of the Backstage is a

navigation pane which is made
up of tabs. These tabs provide

©

Info
Open & Export
Save As

Save as Adobe
PDF

Office Account

Inbox - ivanarobinson@outlook.com - Outlook

Print

Specify how you want the
éﬁ item to be printed and
then click Print.

Print

Printer
HP Universal Printing PCL & .

‘% Offline: 1 document waiting J

[ Print Options

Settings

T —"

you with access to various
operations, such as printing and
saving messages, and
managing rules and alerts. Bt =

Clicking on one of these tabs
brings up a range of options
associated with the particular

operation.

The whole underlying purpose
of the Backstage is to make it

Options

Table Style [ET EEe

Memo Style

Feedback

1 fof1 n B

easier to manage your accounts
and customise Outlook.

Backstage Tabs

The Backstage tabs provide more options for working with an Outlook item.

Info

Open &
Export

Save As

Save
Attachments

Print
Office

Account

Options

Exit

©

Info

Lets you modify account settings, clean your mailbox, and
create and manage rules and alerts.

Lets you open a previously saved calendar or data file, and

import and export files. Open & Expart

Lets you save the current Outlook item under a different
name or location.

Save As

Save as Adobe

Lets you save all attachments in a selected email message. o

Lets you preview and print the current Outlook item.

Lets you sign in and out and switch accounts, select a
different background and theme for your Office applications,

and add and manage services to which you’re connected.

i i Office Account
Provides access to options that allow you to control how

Outlook appears and works.

Options

Lets you exit Outlook. Feedback

Exit
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